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The information contained in this document is subject to change without notice. 

AvantEDGE Corporation assumes no responsibility or obligation of any kind for 

any errors contained herein or in connection with the furnishing, performance, or 

use of this document. 
 

Trademarks or Service Marks 

MagiCure RMC is a registered trademark ® of AvantEDGE Corporation. Other 

brands and products are trademarks of their respective holders. 
 

Copyright 

This document is copyright © 2008 AvantEDGE Corporation. All rights reserved. No 
part of this document may be reproduced in any form, including photocopying or 
translation to another language, without the prior written consent of AvantEDGE 
Corporation. 
 

License and Warranty 

The software that accompanies this license (the ―software‖) is the property of 

AvantEDGE, Inc. (AVT), and is protected by international copyright laws. 

AvantEDGE holds the trademark of MagiCure. You will have certain rights to use 

the software after your acceptance of this license. 
 

You May: 

 

   Install only one copy of the software under one license. 

   Make only one copy of the software for archival purposes. 

 Transfer the software on a permanent basis  

to another entity, provided that you retain no 

copies of the software to AvantEDGE 

Corporation. 
 

You May Not: 

 

   Rent or lease any portion of the software. 

  Reverse engineer, decompile, disassemble, modify, translate, and 
make any attempts to cover the source code of the software, or 
create derivative works from the software. 

 Use a previous version or copy of the software after you have 
received a replacement set or an upgraded version of the software. 
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Limited Warranty  

AvantEDGE Corporation warrants that the media on which the software is distributed will be free 

from defects for a period of thirty (30) days from the delivery date of the software. 

AvantEDGE does not warrant that the software will meet your requirements or that the 

software will be error-free.  

 

Disclaimer of Damages  

IN NO EVENT WILL AVANTEDGE BE LIABLE TO YOU FOR ANY SPECIAL, 

CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST 

PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE 

SOFTWARE EVEN IF AVANTEDGE HAS BEEN ADVISED OF THE POSSIBILITY OF 

SUCH DAMAGES. IN NO CASE SHALL AVANTEDGE’S LIABILITY EXCEED THE 

PURCHASE PRICE FOR THE SOFTWARE.  

The disclaimers and limitations above apply regardless of whether you accept the 

software.  
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About MAGICURE RMC 
 

Thank you for choosing MagiCure Remote Management Console (RMC). This User 

Guide will familiarize your with our product. It includes a complete list of all the 

product's features as well as a brief description of each feature. We strongly 

recommend that you read this User Guide carefully before setting up and exploring 

MagiCure RMC. 

The information contained in this guide is subject to change without notice. 

AvantEDGE assumes no responsibility or obligation of any kind for any errors 

contained herein or in connection with the furnishing, performance, or use of this 

document. 

MagiCure is the pioneer of a new breed of PC instant recovery software. Due to 

ever-increasing system complexity, security threats, and hard drive size in today's 

computers, conventional backup and recovery solutions have become a very time-

consuming and technically-challenging task. Critical events such as system crashes, 

file corruptions, and virus infections can take hours — if not days — to repair. 

MagiCure eliminates the hassles and headaches of troubleshooting common PC 

problems by instantly returning your PC to the time before the onset of the 

problems. And MagiCure RMC enables you to organize and remotely manage client 

workstations with MagiCure software from a graphical console. 
 

 

 

 

 

 

MagiCure RMC Highlights 

 

Clean-cut client and server architecture Scalable architecture: you can have one 
remote management server and several management consoles, or vice versa 
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    Works over Internet connection and proxy servers 

    Requires very little network bandwidth for transmitting client commands;     

       the actual work is done by MagiCure clients 

    User-friendly administrator console 

    Manage multiple MagiCure clients simultaneously 

    Command line switches for integrating RMC with existing help desk        

solutions 

    Create console schedules for automatic tasks 

 

 

What Can MAGICURE RMC Do? 

 

MagiCure RMC enables you, the Administrator, to: 
 

     Monitor client workstations from a graphic console 

     Organize client workstations in groups for easier management 

     Remotely roll back client workstations to snapshots over the Internet 

     Remotely take snapshots on client workstations over the Internet 

     Remotely configure MagiCure client software settings 

     View client workstation properties 

     Remotely defrag MagiCure client workstations 

     Remotely restart, shutdown or wakeup client workstations 

     Remotely access the desktops of Windows XP Professional client workstations 

     Create scheduled tasks to automatically manage client workstations 

     And more! 
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Program Components  
 

MagiCure RMC has two components: the Remote Management 

Server (RMS), and the Remote Management Console (RMC). 

The Remote Management Server is responsible for 

maintaining all client workstation connections to the Remote 

Management Console; it's the core component of MagiCure 

RMC. Without the RMS, client workstations cannot connect to the 

RMC. 

The RMS works just like any Windows system service without a 

user interface; you can start, stop, or restart the service from 

Windows Control Panel > Services. 

The Remote Management Console is the graphical interface 

of MagiCure RMC, through which you can view and manage client 

workstations. The RMC connects to the Remote Management 

Server to manage connected client workstations. 

 

Remote Management Server and Remote Management Console 

can be installed in the same computer or in different computers  
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MagiCure RMC System Requirements 
 

  
The following are the minimum system requirements to run MagiCure RMC: 

 

 Intel® Pentium® III or equivalent processor 

 Microsoft® Windows® XP (Professional or Home Edition), 

Windows 2000; Windows 2000 Server; Windows 2003 

Server; or Windows Vista™* 

 64MB RAM  

 CD/DVD ROM (if you need to setup from a CD Network 

connection) 

 

Setting up MagiCure RMC 
 

As mentioned in Chapter 1, MagiCure RMC has two components: 

the Remote Management Server (RMS) and the Remote 

Management Console (RMC). You can set up these components 

on either the same computer or on different computers. 

For example, you can set up the RMS on an always-available 

network server to maintain client workstations connections, and 

then set up the RMC on your personal laptop. You can then use 

the RMC on your laptop to connect to the RMS on the network 

server, and manage client workstations while you are on the 

network. 
 

To set up the RMS and RMC components on the same 
computer: 

 

1. Start MagiCure RMC Setup by double-clicking setup.exe in the 

program folder. 

2. Read the End User License Agreement (EULA) and click Yes 

to accept it. 

3. Specify the Serial Number received from AvantEDGE. 
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4. (Optional) If you want to run MagiCure RMC in Demo Mode, 

click the Demo button to generate a Demo ID 

Note: Setting up RMC in Demo Mode allows only three client 

workstations to connect to the RMC. 

5. Select a folder to copy the program files to. 

6. Select both the MagiCure Remote Management Server 

and MagiCure Remote Management Console components. 

7. Click Finish to complete the setup and start the MagiCure 

RMC Server service. 

 

To set up the RMS and RMC on different computers: 

 

 

 

1. On the computer in which you want to set up the RMC, start 

MagiCure RMC Setup by double-clicking setup.exe in the 

program folder. 

2. Read the End User License Agreement (EULA) and click Yes 

to accept it. 

3. Specify the Serial Number received from AvantEDGE.  
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4. (Optional) If you want to run MagiCure RMC in Demo Mode, 

click the Demo button to generate a Demo ID. 

Note: Setting up RMC in Demo Mode allows only three client 

workstations to connect to the RMC. 

5. Select a folder to copy the program files to. 

6. Select the MagiCure Remote Management Console 

component. 

7. Click Finish to complete the setup and start the MagiCure RMC 

Server service. 

8. On the computer in which you want to set up the RMS, repeat 

steps 1 – 7, but select the MagiCure Remote Management 

Server component in step 6. 

 

Uninstalling MagiCure RMC 
 

You can uninstall MagiCure RMC using one of the following 

methods: 

 

 Click the Windows Start menu, choose All Programs > 

MagiCure Remote Management Console > Uninstall MagiCure 

RMC 

 From the Windows Control Panel, choose Add/Remove 

Programs > MagiCure RMC 

 

Registering the Console License 
 

The demo version of MagiCure RMC only allows three client 

workstation connections. To connect more client workstations to 

MagiCure RMC, you must register RMC using the license ID 

provided by AvantEDGE. Follow these steps to register license for 

MagiCure RMC:  
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1. From the Help menu in RMC console, choose About and click 
Register. 

 
 
2. Typein the product ID you received from AvantEDGE, and 

then click the Register button. 
 

The demo version of MagiCure RMC allows three (3) MagiCure 
client connections without expiration 

 

Starting and Stopping the RMS Service  

The Remote Management Server (RMS) service is responsible for 

maintaining all client workstation connections via the Remote 

Management Console (RMC); it is the core component of MagiCure 

RMC. Without the RMS, client workstations cannot connect to the 

RMC. 

The RMS works like a Windows system service without a user 

interface. You can start, stop, or restart the RMS from Windows 

Control Panel. Restarting the RMS service will fix most — if not all 

— connection-related issues. 

To start or stop Remote Management Server: 
 

1. From the Windows Control Panel, choose Administrative tools 
> Service. 

2. Select RMC Server from the list of available services. 

3. If the service is stopped, click the Start button to start the 

service; if the service is running, click the Stop button to stop 

the service.  
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Changing the RMC Server Service Port 
By default, the MagiCure RMC Server service uses TCP port 9000 for 

client connections. However, port 9000 on your computer may have 

been taken over by another application. 

To configure the RMC Server service to use another TCP 

Port:  

 

1. Stop the RMS service as described above. 

2. Go to the folder c:\program files\rmc and open the file 

Config.txt with a text editor. 

3. Change "TCP_PORT=" to a new port number 
and save the file. 

4. Restart the RMS service.  

 

Managing the RMC Console 

Everything you do within the MagiCure RMC console can be 

divided into two categories: tasks related to the console (for 

example, configuring the RMC console) and tasks related to 

connected client PCs (for example, managing MagiCure clients). 

The tasks related to RMC console are:  
 

 Customizing the console view 

 Creating console administrators 

 Creating console groups 

 Importing/exporting console group settings 

 Creating console-based scheduled tasks 

 Viewing console logs 

 Registering the console license 
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Customizing the Console View 

You can view client workstations from the MagiCure Remote 

Management Console using one of the following two options:  
 

Large Icon View  

Detailed View  
 

The Large Icon View:  

 

Displays the client workstations as icons in the RMC console; 

each icon has the client PC's name. 

Indicates which client workstations are online or offline. 

Icons with a gray monitor indicate client workstations that 

are currently offline; icons with a blue monitor indicate client 

workstations that are currently online. 

Enables you to select multiple client workstation icons. 

Simply click your mouse in an area above the icons and then 

drag the mouse over the icons. Alternatively, hold down the 

Ctrl key while clicking the relevant client workstation icons. 

Lets you drag and drop the client workstation icons to any 

area of the RMC console. 
 

The Detailed View:  

 

Displays client workstations in a detailed list in the RMC console. 

Displays the following properties for each client workstation: 

computer name, the network it belongs to, the operating 

system, the OS service pack number, memory, IP address, 

status (online or offline), disk size, and free space. 
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Enables you to customize the detailed view list: right-click the 

list header and select or de-select header settings. 

Indicates which client workstations are online or offline. 

Icons with a gray monitor indicate client workstations that 

are currently offline; icons with a blue monitor indicate client 

workstations that are currently online. 

Allows you to select multiple client workstation icons. Simply 

click your mouse in an area above the icons and then drag the 

mouse pointer over the icons. Alternatively, hold down the 

Ctrl key while clicking the relevant client workstations icons. 

To change MagiCure RMC console views 

 In the RMC console, click the View menu. You can set the view 

setting to: 
 

View all MagiCure clients 

View online MagiCure clients only 

View client workstations by computer name, system type, 

status, or client type. 

Creating Console Administrators 

To access the MagiCure RMC console, you need an administrator user 

account and password. The MagiCure RMC Console administrator 

account is "Administrator" with no password  

 

To change console administrator password 

 
1. From the Console menu in the RMC console, choose Change 

password. 

2. Enter the..... 

 

The built-in Administrator account cannot be removed.  
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To create a new console administrators  

 

1. From the Console menu in the RMC console, choose 

Administrators. 

2. Click Add to create a new administrator. 

 

To delete console administrators 

1. From the Console menu in the RMC console, choose 

Administrators. 

2. Select an administrator account and click Remove to delete 

it. 

Creating Console Groups 

The MagiCure RMC console enables you to organize client 

workstations in groups for easy client management. MagiCure RMC 

lets you work with two type of group: 
 

 System Groups — default groups provided by MagiCure RMC  

 Custom Groups — groups created by administrators.  

System Groups 

MagiCure RMC provides the following default system groups: 
 

 All clients 

 Windows 9x clients 

 Windows NT/XP clients 

 Low-space clients 

 Registered clients 

 Unregistered clients 
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New clients connected to MagiCure RMC are automatically 

registered in system groups according to their qualifications 

 

To create new custom groups 

 

1. From the Console menu in the RMC console, choose Groups. 

2. Click New to create a group. 

To add or remove client workstations to or from custom 

groups 
 

1. From the Console menu in the RMC console, choose Groups. 

2. Select a group in the Group list and click Modify. 

3. From the RMC console, drag and drop the relevant client 

workstation icons to the target group. 

 

 

A client workstation can be a member of multiple groups; for 

example, PC-1 can be a member of both the Development 

group and the QA group  

To rename or delete custom groups 

 In the RMC console, right click the group and choose Rename 

or Delete from the popup menu. 
 
 

System Groups cannot be renamed or deleted. 

 

 

 

 

 

MagiCure™  
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Importing and Exporting Custom Groups 
Settings 
 

To export custom group settings to backup files or import 

group settings from backup files 

 From the File menu in the RMC console, choose Import Group 

Settings or Export Group Settings. 

 

Using the Console Scheduler 
 

To schedule a MagiCure RMC console scheduled task  

 

 From the Console menu in the RMC console, choose Console 
scheduled tasks and then click Add. 

 

You can schedule the following tasks with the console scheduler: 
 

 Rollback clients 
 Snapshot clients 

 Defrag clients 

 Restart clients 

 Shutdown clients 

 Wakeup clients 

 

Accessing Console Logs 

MagiCure RMC console logs maintain detailed records of 

administrator activities. They also provide valuable information 

for troubleshooting RMC console problems. 

To access MagiCure RMC console logs 

 From the File menu in the RMC console, choose Logs. 

 

You can set different logging level for MagiCure RMC console.  

 

 

MagiCure™ RMC  
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Registering the MagiCure RMC 
 
The demo version of MagiCure RMC allows only three client 

workstation connections. To connect more client workstations to 

MagiCure RMC, you must register RMC with a license ID provided 

by AvantEDGE.  

 

To register the MagiCure RMC 

 

1. From the Help menu in the RMC console, choose About and 
then click Register. 

2. Insert the product ID received from AvantEDGE and click on 

the register button.  
 
 

The demo version of MagiCure RMC allows three MagiCure client connections 
without expiration. 

 

Managing MagiCure Clients  

Everything you do within MagiCure RMC console can be divided 

into two categories: tasks related to the console (such as 

configuring the RMC console) and tasks related to connected 

client PCs (such as managing MagiCure clients). The tasks related 

to client workstations are: 

 

 Roll back client workstations 

 Create snapshots 

 Reset client workstations to baseline 

 Update  baseline 

 Delete  snapshots 

 Defrag  snapshots 
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Configure client workstation settings 

Restart client workstations 

Shut down client workstations 

Wake up client workstations 

Activate client workstations 

 

Rolling Back Clients 
 

To roll back client workstations to a snapshot 

 

1. In the RMC console, select the group or the clients you want to 

roll back 

2. Right-click the selection and choose Rollback Clients from the 

popup menu.  

3. Select one of the following rollback options: 
 

Rollback clients to the baseline snapshot 
Rollback clients to the latest snapshot 

Rollback clients to a snapshot before ____ time 

Rollback clients to a specific snapshot ____, snapshot name 

4. Click OK to reboot the client workstations. 

5. Optionally, you can set a timer for how soon you want to 

reboot the clients.  

 

You can also create a console scheduled task to roll back 

clients.  

 

Taking a Snapshot of Clients 
 

To take a new snapshot on client workstations 

 

1. In the RMC console, select the group or the clients you want 

to take a snapshot of. 

2. Right-click the selection and choose Snapshot Clients from 

the popup menu. 

 

MagiCure™ RMC  
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3. Type in a name and description for the new snapshot. 

4. Optionally, you can select to lock the new snapshot in order 

to prevent it from auto deletion. 

You can also create a console scheduled task to take 

snapshots of clients 

 

Resetting Clients to the Baseline 
 

To reset client workstations to the baseline snapshot  

 

1. In the RMC console, select the group or the clients you want 

to reset to the baseline. 

2. Right–click the selection and choose Reset to Baseline from 

the popup menu.  

3. Click OK to reboot the client workstations. 

4. Optionally, you can set a timer for how soon you want to 

reboot the clients  

 

Updating Client Baselines 
 

You can update client baseline snapshots in order to include the 

latest system configuration and data. 

 

To update client workstation baseline snapshots 

 

1. In the RMC console, select the group or the clients whose 

baseline snapshots you want to update. 

2. Right-click the selection and choose Update Baseline from 

the popup menu. 

3. Click OK to reboot the clients. 

4. Optionally, you can set a timer for how soon you want to 

reboot the clients.  

 

 

MagiCure™ RMC  
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Deleting Snapshots  
 

You can delete some or all of the snapshots from selected client 

workstations. 

 

To delete snapshots from client workstations 

 

1. In the RMC console, select the group or the clients whose 

snapshots you want to delete. 

2. Right click the selection and choose Delete Snapshots from 

the popup menu.  

3. Select one of the following delete options, and then click 

OK:  
 

 Delete all unlocked snapshots 

 Delete all unlocked  type  ____ snapshots 

 Delete all unlocked snapshots more than x days old 

 Delete all unlocked snapshots taken before x (time) 

 Delete all unlocked snapshots take after x (time) 
 
 

In order to delete locked snapshots, you must first unlock them.  

 

Defragmenting Snapshots 

 
To defragment client workstation snapshots  

 

1. In the RMC console, select the group or the clients whose 

snapshots you want to defragment. 

2. Right-click the selection and choose Defrag Snapshots from 

the popup menu. 

3. Click OK to start the defragmenter. 
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You can also create a console scheduled task to defrag snapshots.  

 

Configuring Client Settings 
 

To configure MagiCure client workstations settings 

 

1. In the RMC console, select the group or the clients for whom 

you want to configure MagiCure client settings. 

2. Right-click the selection and choose Configure Client 

Settings from the popup menu. 

3. Click the appropriate links to configure the following client 
settings:  

 

Program Appearance 
 

 Show or hide MagiCure client workstations’ desktops 

 Show or hide MagiCure program logo during startup 

 Remind users to run missed scheduled tasks 

 Allow users to cancel scheduled tasks 

 Show or hide user logon name 

 Show or hide popup messages when taking scheduled  

snapshots 

Advanced Settings 
 

 Enable or disable access control 

 Change MagiCure clients’ administrator passwords 

 Enable or disable system security 

 Add or remove scheduled tasks 

 Disable or enable direct disk I/O 

 Rollback system settings 

 Delete snapshots settings 

 Optimize snapshot's index settings 

 Defrag snapshots settings 

 

 

 

 

MagiCure™ RMC  
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Restarting Clients 
 

To restart client workstations 

1. In the RMC console, select the group or the client 

workstations you want to restart. 

2. Right-click the selection and choose Restart Clients from the 

popup menu. 

3. Optionally, you can set a timer for how soon you want to 

restart the clients. 

 

You can also create a console scheduled task to restart clients.  

 

Shutting Down Clients 
 

To shut down client workstations 

 

1. In the RMC console, select the group or the client 

workstations you want to shut down. 

2. Right-click the selection and choose Shutdown Clients from 

the popup menu. 

3. Optionally, you can set a timer for how soon you want to 

shut down the clients.  

 

You can also create a console scheduled task to shut down 

clients.  
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Waking up Clients 
 

To wake up offline client workstations 

 

1. In the RMC console, select the group or the offline client 

workstations you want to wake up. 

2. Right-click the selection and choose Wakeup Clients from 

the popup menu. 

 

Activating MagiCure Clients 
 
MagiCure clients contain software-based product activation 

technology. This means you must activate your copy of 

MagiCure in order to use it permanently. MagiCure RMC allows 

you to remotely activate MagiCure clients from a central control. 

You can activate MagiCure regardless of whether you have an 

Internet connection. 
 

Activating MagiCure clients through an Internet 
connection 
 

If the MagiCure client workstations have Internet connections, 

you can use MagiCure RMC to guide the clients to activate their 

workstations over the Internet as follows: 

 

1. 1. In the RMC console, select the group or client whose 

workstations you want to activate. 

2. Right-click the selection and choose Activate Clients from the 

popup menu.  

3. Select the Activate clients over the Internet connection 

option. 
 

 

 

 

 

MagiCure™ RMC  
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4. If the MagiCure clients were installed with a demo product ID, 

type the product ID provided by AvantEDGE into the 

Product ID field. 

5. Click Activate. The MagiCure Client PCs will restart in order 

to complete the activation process. 

6. Optionally, you can set a timer for how soon you want to 

restart the clients.  

 

Activating MagiCure clients without an Internet 
connection  
 

If the MagiCure clients do not have Internet connection, you 

can use MagiCure RMC as the activation server to activate the client 

PCs. 

 

1. 1. In the RMC console, select the group or client workstations 

you want to activate. 

2. Right-click the selection and choose Activate Clients from 

the popup menu. 

3. Select The clients do not have Internet connection and 

then click Next. 

4. Perform the following three easy steps to activate the client 

workstations without an Internet connection: 

a. a). Collect and save the clients’ product activation information. 

b. b). Send the information to AvantEDGE in order to 

generate a license file. 

c. c). Activate the client workstations with the license file 

provided by AvantEDGE.  
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Support Options 

AvantEDGE is committed to providing quality support and 

excellent service to our valued customers. Our goal is to provide 

you with professional assistance in using our software through the 

variety of methods including documentation as well as online or 

personal contacts. Our experience with customers has shown that 

most of their questions can be answered in our Frequently Asked 

Questions (FAQ) Web page or other various technical white 

papers. 

Please check your questions in the FAQ before proceeding with 

other support options. 

 

If you were not able to find answers to your questions in the 

MagiCure FAQ and Knowledge Base, go to the AvantEDGE Web 

site support page for more product-related documents, white 

papers, and other sources of information. You can find our support 

page at the following address: 

http://www.magicuresoft.com/support  

 

 

In addition, our AvantEDGE customer service representatives can 

assist you with non-technical questions. Visit the AvantEDGE 

support and service Web site to find your local customer service 

number to:  
 

 Place an order  

 Find a distributor in your area  

 Update your registration information  

 

http://www.magicuresoft.com/support
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FAQ 

For a list of Frequently Asked Questions about MagiCure,  

please visit: http://www.magicuresoft.com/support  

 

Help Desk 
 
AvantEDGE provides an easy to use help desk system: 

http://www.magicuresoft.com/support  

There you can submit support tickets and get answers from our 

support technicians.  

 

Remote client management  

 

http://www.magicuresoft.com/support
http://www.magicuresoft.com/support

